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READ CAREFULLY BEFORE USING!
CANON SOFTWARE LICENSE AGREEMENT
IMPORTANT - READ THIS AGREEMENT BEFORE USING THE SOFTWARE ON THE
CD-ROM IN THIS BOX.  BY USING THE SOFTWARE, YOU AGREE TO BE BOUND BY THE
TERMS OF THIS AGREEMENT.

This is a license agreement (the [Agreement]) between you and Canon Inc. ([Canon]).

IF YOU DO NOT AGREE TO THE TERMS AND CONDITIONS OF THIS AGREEMENT, DO
NOT USE THE SOFTWARE PROGRAM ON THE CD-ROM AND THE USER MANUAL IN
THIS BOX (COLLECTIVELY, THE [SOFTWARE]) AND RETURN THE SOFTWARE WITHIN
30 DAYS FROM THE DATE OF PURCHASE TO YOUR POINT OF PURCHASE FOR A
REFUND.

In consideration of the right to use the SOFTWARE, you agree to abide by the terms and
conditions of this Agreement.

1.  LICENSE:  Canon grants you the non-exclusive right to use the SOFTWARE only on a
single computer.  You may physically transfer the SOFTWARE from one computer to
another provided that the SOFTWARE is used on only one computer at a time.  You shall
not install or use the SOFTWARE on a network, multiple CPU, multiple site arrangement,
or any other hardware configuration where the SOFTWARE is accessible to more than one
CPU or to more than one user.

YOU SHALL NOT ASSIGN, SUBLICENSE, RENT, LEASE, LOAN, CONVEY OR
OTHERWISE USE, TRANSFER, COPY, TRANSLATE, CONVERT TO ANOTHER
PROGRAMMING LANGUAGE, ALTER, MODIFY, DECOMPILE OR DISASSEMBLE THE
SOFTWARE, IN WHOLE OR IN PART, EXCEPT AS EXPRESSLY PROVIDED IN THIS
AGREEMENT.

2.  BACK-UP COPY:  You may make one copy of the SOFTWARE solely for back-up
purposes, or copy the SOFTWARE onto the permanent storage device (e.g. a hard disk) of
your computer and retain the original for back-up purposes.  Any other copying of the
SOFTWARE is a violation of this Agreement.  You must reproduce and include the
copyright notice on the back-up copy.

3.  SUPPORT AND UPDATES:  Canon is not responsible for providing maintenance or
support for use of the SOFTWARE.  No updates, fixes or support will be made available for
the SOFTWARE.

4.  LIMITED WARRANTY AND LIMITATION OF LIABILITY:  It is your responsibility to choose,
maintain and match the hardware and software components of your computer system.
Thus Canon does not guarantee uninterrupted service or correction of errors or that the
functions or performance of the SOFTWARE will meet your requirements.  THE
SOFTWARE IS LICENSED ON AN [AS IS] BASIS AND WITHOUT WARRANTY OF ANY
KIND. The CD-ROM storing the SOFTWARE is warranted only against defective material
under normal use for a period of ninety (90) days after purchase from an authorized Canon
dealer as evidenced by your sales receipt. Your sole remedy for a defective CD-ROM shall
be replacement of the same without charge when returned by you at your expense to your
point of purchase and proven to be defective upon inspection.  The replacement CD-ROM
will be warranted for the remainder of the original ninety (90) day warranty period of the
defective CD-ROM.  The limited warranty does not apply if the failure of the CD-ROM
resulted from accident, abuse or misapplication of the SOFTWARE and shall not extend to
anyone other than the original user of the SOFTWARE.

EXCEPT AS SPECIFICALLY SET FORTH IN THIS PARAGRAPH 4, CANON, CANON’S
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SUBSIDIARIES, DISTRIBUTORS AND DEALERS DISCLAIM ALL WARRANTIES, EXPRESS
OR IMPLIED, INCLUDING ANY WARRANTY OF MERCHANTABILITY OR FITNESS FOR A
PARTICULAR PURPOSE, WITH RESPECT TO THE SOFTWARE.

NEITHER CANON NOR ANY OF CANON’S SUBSIDIARIES, DISTRIBUTORS OR DEALERS
IS LIABLE FOR ANY DAMAGES HOWSOEVER CAUSED, INCLUDING WITHOUT
LIMITATION, DIRECT, CONSEQUENTIAL OR INCIDENTAL LOSS OR DAMAGE INCLUDING
LOSS OF PROFITS, EXPENSE OR INCONVENIENCE HOWSOEVER CAUSED OR
ARISING OUT OF THE SOFTWARE OR THE USE THEREOF.

NEITHER CANON, NOR ANY OF CANON’S SUBSIDIARIES, DISTRIBUTORS OR DEALERS
SHALL HAVE ANY OBLIGATION TO INDEMNIFY YOU AGAINST ANY CLAIM OR SUIT
BROUGHT BY A THIRD PARTY ALLEGING THAT THE SOFTWARE OR THE USE THEREOF
INFRINGES ANY INTELLECTUAL PROPERTY OF SUCH THIRD PARTY.

5.  TERM:  This Agreement is effective upon your using the SOFTWARE and remains in effect
until expiration of all copyright interests in the SOFTWARE unless earlier terminated.  You
may terminate this Agreement by destroying the SOFTWARE.  This Agreement will also
terminate without notice to you if you fail to comply with any of the terms of this Agreement
and you must then promptly return the SOFTWARE.  In addition, Canon may enforce its
other legal rights.

6.  U.S. GOVERNMENT RESTRICTED RIGHTS NOTICE:  The SOFTWARE is provided with
restricted rights.  Use, duplication or disclosure is subject to restrictions as set forth in
either subparagraph (c) (1) (ii) of the Rights in Technical Data and Computer software
clause at DFARs 252.227-7013 or subparagraph (c) (1) and (2) of the Commercial
Computer Software Restricted Rights Clause at FAR 52.227-19, as applicable.

7.  SEVERABILITY:  In the event that any provision of this Agreement is declared or found to
be illegal by any court or tribunal of competent jurisdiction, such provision shall be null and
void with respect to the jurisdiction of that court or tribunal and all the remaining provisions
of this Agreement shall remain in full force and effect.

8.  CONTROLLING LAW:  The terms of this Agreement as it relates to purchases of the
Software in the United States of America shall be governed and construed in all respects in
accordance with the laws and regulations of the State of New York, without reference to
choice of law principles.  The terms of this Agreement as it relates to purchases of the
Software in Canada shall be governed by the laws of the province of Ontario.

9.  OWNERSHIP:  All rights, including but not limited to copyrights and trade secret rights, to
the SOFTWARE belong to Canon, its affiliated corporations and third party licensors.  Your
use of the SOFTWARE is subject to the United States, Canada and other applicable
copyright and trademark laws and nothing in this Agreement constitutes a waiver of the
rights of Canon, its affiliated corporations and third party licensors under such laws.
Nothing contained in Paragraph 1 shall be construed to give Canon any ownership rights in
any images, graphics or textual material that you save in connection with the Software.

10. ACKNOWLEDGEMENT:  BY USING THE SOFTWARE, YOU ACKNOWLEDGE THAT YOU
HAVE READ THIS AGREEMENT, UNDERSTOOD IT, AND AGREE TO BE BOUND BY ITS
TERMS AND CONDITIONS.  YOU ALSO AGREE THAT THIS AGREEMENT IS THE
COMPLETE AND EXCLUSIVE STATEMENT OF AGREEMENT BETWEEN YOU AND
CANON CONCERNING THE SUBJECT MATTER HEREOF AND SUPERSEDES ALL
PROPOSALS OR PRIOR AGREEMENTS, VERBAL OR WRITTEN, AND ANY OTHER
COMMUNICATIONS BETWEEN THE PARTIES RELATING TO THE SUBJECT MATTER
HEREOF.  NO AMENDMENT TO THIS AGREEMENT SHALL BE EFFECTIVE UNLESS
SIGNED BY A DULY AUTHORIZED OFFICER OF CANON.
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Safety Precautions
Please read the safety precautions carefully before using this product. Ensure that you use the
product correctly according to the procedures described in these instructions.
The following safety precautions are intended to instruct you in the safe and correct operation
of the product and its accessories to prevent injuries or damage to yourself, other persons and
property. Please read and ensure that you understand them before you proceed to the other
sections of these instructions.

Warning

Do not play the supplied CD-ROM(s) in any CD-ROM Player that does not support data
CD-ROMs. The extremely loud sound that may result from playing the CD-ROM(s) in an
audio CD player (music player) could damage the speakers. It is also possible to suffer
hearing losses from listening with headphones to the loud sounds of a data CD-ROM played
on a music CD player.

Disclaimer
• While every effort has been made to ensure that the information contained in these

instructions is accurate and complete, no liability can be accepted for any errors or omissions.
Canon reserves the right to change the specifications of the hardware and software
described herein at any time without prior notice.

• No part of these instructions may be reproduced, transmitted, transcribed, stored in a
retrieval system, or translated into any language in any form, by any means, without the
prior written permission of Canon.

• Canon makes no warranties for damages resulting from corrupted or lost data due to a
mistaken operation or malfunction of the camera, the software, the CompactFlash™ cards
(CF cards), personal computers, peripheral devices, or use of non-Canon CF cards.

Trademark Acknowledgments
• Canon and EOS are trademarks of Canon Inc.
• Adobe and Photoshop are trademarks of Adobe Systems Incorporated.
• CompactFlash is a trademark of SanDisk Corporation.
• iBook, iMac and QuickTime are trademarks of Apple Computer Inc.
• Macintosh, PowerBook, Power Macintosh and FireWire are trademarks of Apple Computer

Inc., registered in the United States and other countries.
• Windows is a registered trademark or trademark of Microsoft Corporation in the United

States and/or other countries.
• Other names and products not mentioned above may be registered trademarks or

trademarks of their respective companies.

About These Instructions and the Symbols Used
The information in these instructions is valid for the Mac OS 9 operating systems.
Descriptions of EOS D60 operations assume that the reader is familiar with the information
in the bundled EOS D60 Instructions. For detailed information on how to use the software
products and the restrictions that apply to those products, refer also to the Help and
Readme files for the respective products.

: Marks information that should be read before use to prevent damage to the camera,
camera malfunction, or problems that would interfere with the functioning of software
and computer.

: Marks additional information that you will find helpful when using the camera or
software.
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Safety Precautions

About the ImageBrowser Software Guide
A PDF-format Software Guide that provides detailed instructions for using ImageBrowser is
included on the EOS DIGITAL SOLUTION DISK. You will need Adobe Acrobat Reader to view
the Software Guide. If you have not already installed Adobe Acrobat Reader on your computer,
install it using the procedure below.

Installing Acrobat Reader
1 Load the EOS DIGITAL SOLUTION DISK into the CD-ROM drive.
2 Double-click the following in sequence: the SOLUTION DISK icon s the [Readme] folder

s the [English] folder s the [Acrobat] folder s [Reader Installer].
3 Proceed with the installation as directed by the on-screen messages.

Viewing the ImageBrowser Software Guide
1 Load the EOS DIGITAL SOLUTION DISK into the CD-ROM drive.
2 Double-click the SOLUTION DISK icon s the [Canon Digital Camera Installer] icon.

/ The Installer panel appears.
3 Click [Using the software].
4 Click [ImageBrowser].

/ Acrobat Reader starts up and the [ImageBrowser Software Guide] appears.

About QuickTime
To save composite images made using PhotoStitch in the QuickTime VR format, you will need
QuickTime 3.0 or later. If you have not already installed QuickTime 3.0 or later on your
computer, install it using the procedure below.

1 Load the EOS DIGITAL SOLUTION DISK into the CD-ROM drive.
2 Double-click the SOLUTION DISK icon s the [Canon Digital Camera Installer] icon.

/ The Installer panel appears.
3 Click [QuickTime 5.0 Installation].
4 Proceed with the installation as directed by the on-screen messages.
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About the Software
This section briefly describes the main functions of the software provided on the bundled CD-
ROM.

■ EOS DIGITAL SOLUTION DISK
Plug-In Module

● Enables you to display, save and erase images.
● Allows you to process RAW images and then perform image processing.

USB Mounter
● This utility allows you to treat the camera like a computer drive or read-only card reader,

displaying the CF card contents on the computer and permitting files to be downloaded as if
they were being copied from a card reader.

ImageBrowser
● You can automatically start this program and use it to display the images stored on the EOS

D60 simply by connecting the camera to your computer’s USB port. To download images
from the EOS D60 to your computer, select the thumbnails (a list of reduced images) on the
computer screen.

● This program displays downloaded images in lists and allow you to sort and organize them
by content.

● This program can display images in order according to the shooting date.
● You can use ImageBrowser to change the size and compression rate of an image and then

save the modified image.

RAW Image Converter
● This program processes RAW images that you shot on the EOS D60 and saved onto your

computer. You can also use this program to save your images in popular formats such as
TIFF (8 or 16 bits/channel) and JPEG.

PhotoStitch
● PhotoStitch provides an easy way to merge a series of overlapping images into a single,

seamless panorama by automatically arranging the frames in order. You can use this
feature to stitch your shots together into one complete 360° cylinder-shaped panorama
image.

RemoteCapture
● RemoteCapture allows you to operate the EOS D60 remotely and download images to your

computer. RemoteCapture also lets you take pictures using a timer shooting or interval
timer shooting function, in addition to single-frame shooting.
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About the Software

■ Adobe Photoshop 5.0 LE DISK
Photoshop 5.0 LE

● This is a full-featured image retouching program equipped with a complete range of image
processing functions. You can also use Photoshop 5.0 LE to start the Plug-In Module.

● You can use the Plug-In Module to display images saved on your computer and to image-
process your saved images.
* If you already have Photoshop 5.0 LE installed on your computer, you do not need to install it again.
* Explanations for the Plug-In Module-compatible application in these instructions all use examples from

Photoshop 5.0 LE.
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Computer

OS

CPU

RAM

Interface

Hard disk space

Display

Macintosh computer equipped with a USB port as a standard feature
(users of first-generation iMacs require a firmware update. ➞9-2)

Mac OS 8.6 to 9.2 (Mac OS 9.0 or later recommended)

Power PC

Minimum 64 MB of application memory required, 128 MB or more
recommended

USB

Plug-In Module 15 MB or more
USB Mounter   5 MB or more
ImageBrowser 20 MB or more
PhotoStitch 30 MB or more
RAW Image Converter 15 MB or more
RemoteCapture 15 MB or more
Adobe Photoshop 5.0 LE 40 MB or more

800 × 600 dots, 256 colors or more required
1024 × 768 dots, 32,000 colors or more recommended

Computer System Requirements

● A CD-ROM drive is required for software installation.
● USB Mounter is compatible with Mac OS 9.0 or later.
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This chapter describes the procedure for installing the software for EOS
D60 and Photoshop 5.0 LE.

Installing the Software
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● You must follow the procedure given below to install the software.

1.  EOS DIGITAL SOLUTION DISK

2.  Photoshop 5.0 LE

Do not connect the camera to your computer before you have installed the software as
this will prevent successful software installation.

EOS DIGITAL SOLUTION DISK Installation

1 Start up your computer.
● Close any programs that are running before you begin installing the software.

2 Load the SOLUTION DISK into the CD-ROM drive.
\ The SOLUTION DISK icon appears on the desktop.

3 Start the installer.
● Double-click the SOLUTION DISK icon s the [Canon Digital Camera Installer] icon

to start.
\ The Installer panel appears.

4 Click [Digital Camera Software Installation].

Installing the Software
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Installing the Software

5 Select the software to be installed.
● Click the checkboxes for the

software to be installed and then
click the [Install] button.

6 Read all of the Software User License Agreement carefully. If you
agree to the terms of the license, click the [Agree] button.

7 Select the folder in which the software will be installed and then
click the [Choose] button.

8 Proceed with the installation as directed by the on-screen
messages.
\ When installation ends, a restart dialog box appears.

9 Click the [Yes] button and restart your computer.

10Copy the Plug-In Module to the software you will use.
● Copy the [Canon Camera Plug-In 4] file in the [Camera Plug-In] folder located

inside the [Canon Utilities] folder to the plug-ins folder for the software you are
using. Then restart your computer.

● For the bundled Photoshop 5.0 LE application, after you have installed Photoshop
5.0 LE, copy the [Canon Camera Plug-In 4] file to the [Import/Export] folder located
inside the [Plug-Ins] folder in the [Adobe Photoshop 5.0 LE] folder. Then restart
your computer.
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Installing the Software

Installing Photoshop 5.0 LE
● You are required to enter the serial number during Photoshop 5.0 LE installation. The serial

number is as follows:

SDM501B4164785-650

1 Load the Adobe Photoshop 5.0 LE CD-ROM into the CD-ROM
drive.
\ The CD-ROM folder automatically opens.
● If the folder does not open automatically, double-click the CD-ROM icon on the

desktop.

2 Double-click the [English] folder and then the [Adobe Photoshop
5.0 LE] folder to open.

3 Double-click the [Install Photoshop LE] to start.

4 Proceed with the installation as directed by the on-screen
messages.
● For more information on the installation procedure, refer to the [Read Me] file inside

the [English] folder on the Photoshop 5.0 LE CD-ROM.

Specify at least 40 MB as the memory allocated to Photoshop 5.0 LE. For more
information on how to allocate memory to an application, refer to the User’s Manual for
your computer.

Please Register Your Camera!
We recommend you take a moment to register your camera, in order to receive further product
information.
To proceed to the online User Registration page, simply click the [User Registration] button
from the [EOS DIGITAL SOLUTION DISK].
If there is no response when you click the [User Registration] button, start your Internet
browser program (such as Microsoft Internet Explorer or Netscape Communicator), then go to
the [Html] folder on the SOLUTION DISK and open the [regist.html] file inside the [English]
folder.
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This chapter explains how to connect the camera to your computer and
how to use a card reader (third-party product).

Getting Ready to Work with
Images
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Connecting the Camera to Your Computer
Connect the EOS D60 to your computer with the interface cable so that they can
communicate. You can connect the camera while your computer is running.
The ImageBrowser starts up automatically when you connect the camera. Note that you have
the option of disabling ImageBrowser auto start.

1 Plug the interface cable into the computer.
● Plug the cable into the USB port

on the computer.
● The location of the port differs

depending on your computer.
Refer to the User’s Manual for
your computer for details.

2 Plug the interface cable into your camera.
● Open the cover and plug in the

interface cable so that the t mark
on the plug is aligned with the t
beside the DIGITAL terminal.

3 Set the camera’s main switch to <ON>.
\ ImageBrowser starts up.
● See Chapter 8 “Working with Images in ImageBrowser” for more information on

ImageBrowser.

USB port

Interface
cable

Interface
cable

t mark

DIGITAL terminal

t mark
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Connecting the Camera to Your Computer

● Use only the interface cable bundled with the camera to connect the camera to your
computer.

● Push the plug firmly all the way into the socket. Loose connections can cause faults
or malfunctions.

● Connect the camera directly to a USB port on the computer; not through a hub. The
connection may not operate correctly through a hub.

● The connection may not operate correctly if you are using other USB devices,
excluding USB mouse or keyboards, at the same time. If this occurs, disconnect the
other devices from the computer and try reconnecting the camera.

● Do not connect more than one camera to the same computer. The connections may
not operate correctly.

● While the camera and your computer are communicating, the camera’s LCD panel
may blink and, if you are using the LCD monitor, the image on the monitor may
flicker. This is not malfunction.

● When you unplug the interface cable from the camera’s
DIGITAL terminal, press the PUSH button on the plug as
you pull the plug out.

● If you leave the camera unused for approximately 5
minutes while it is connected to your computer, a
confirmation message appears on the computer screen
asking whether you wish to continue communicating with
the camera. If you do not do anything, the connection to the
camera is terminated after approximately 1 minute. (If you are using a household
power source, no message is displayed and the connection is not terminated.) To
re-establish the connection, press the shutter button down halfway or set the
camera’s main switch to <OFF> and then back to <ON>.
Refer to the EOS D60 Instructions provided with the camera for details.

● To set up the software so that ImageBrowser does not start up when you connect
the camera to your computer, see “Disabling ImageBrowser Auto Start” (➞8-4).

● Do not put your computer to sleep while it is connected to the camera.
If you do put your computer to sleep while it is connected to the camera, never
disconnect the interface cable while your computer is still in sleep mode. Always
wake your computer up before disconnecting the camera. On some types of
computer, disconnecting the interface cable while your computer is in sleep mode
could prevent the computer from waking up correctly. Refer to the computer User’s
Manual for more information on Sleep mode.

PUSH button

When you connect your camera to a computer, you should use the DC Coupler Kit so
that you can continue to use your camera regardless of battery level.
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Inserting a CF Card into Your Card Reader
To download images from a CF card directly onto your computer, remove the CF card from
your camera and load it into a card reader (third-party product) connected to your computer.

1 Remove the CF card from the camera.

2 Load the card into the card reader.

CF Card Folder Structure and File Names
The images on a CF card are placed in sub-folders named [XXXCANON], where the “XXX”
represents a number from 100 to 998, within the [DCIM] folder.

● The “xxxx” in file names represent four-digit numbers.
● All folders except the “XXXCANON” folders contain image control files. Do not open or

delete them.
* Files with the THM extension are the thumbnail image files for the camera’s index replay mode.

IMG_xxxx.JPG (JPEG images)

CRW_xxxx.CRW (RAW images)

CRW_xxxx.THM*

The folder that holds the image control files in the DCIM folder.

The folder created when DPOF settings are set.
It holds the DPOF settings files.

For information on connecting the card reader to your computer, refer to the User’s
Manual provided with the card reader.
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This chapter explains how to use the Plug-In Module to display and save
images stored on a CF card loaded in the camera and describes how to
process and image-process RAW images.

Working with Images in the
Plug-In Module
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The Plug-In Module software starts from a Plug-In Module-compatible application (such as
Adobe Photoshop 5.0 LE). The descriptions given here use the bundled Photoshop 5.0 LE
software as an example.
If you are using Plug-In Module-compatible application other than Photoshop 5.0 LE, refer to
the User’s Manuals provided with your software for information on setting up and using TWAIN
devices.

1 Start Photoshop 5.0 LE.
● Open the [Adobe Photoshop 5.0 LE] folder in the location specified during

installation and double-click the [Adobe Photoshop 5.0 LE] icon inside the folder to
start the application.

● When you connect the camera to your computer, the [ImageBrowser Automation
wizard] dialog box appears. Click the [Cancel] button and then close ImageBrowser.

● To set up the software so that ImageBrowser does not start up when you connect
the camera to your computer, see “Disabling ImageBrowser Auto Start” (➞8-4).

\ Photoshop 5.0 LE starts up.

2 Select [File] menu s [Import] s [Canon Camera Plug-In 4...].
\ The Plug-In Module starts up.
\ The [Communication Settings]

dialog box appears.
● If the [Communication Settings]

dialog box does not appear, click
the [Communication Setup] button.

Starting the Plug-In Module

3 Confirm that [USB Port] is selected in the [Port] list box and that
[EOS D60] is selected in the [Detected Camera] list box, then click
the [Set] button.
\ The main window opens. In the

main window, you can display and
process the images saved on the
CF card in the camera.

● To close the Plug-In Module, click
the [Exit] button in the main
window.
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Starting the Plug-In Module

Display Mode list box
(➞3-9)

Display Size list box (➞3-11)

Image display format
list box (➞3-8) Image transfer mode

list box (➞3-32)

Image information
display area
(➞3-16)

Comment input box (➞3-16)

Status bar

Camera Settings button
(➞6-2)

Preferences button
(➞3-29)

Rotate left 90 degrees
button (➞3-17)

Rotate right 90 degrees
button (➞3-17)

Display AF point button
* Images shot on the EOS

D60 are not compatible
with this function.

Select image folder display area
(➞3-5)

Plug-In Module main window
Path display
Displays the connected camera
name and folder name.

Communication Setup
button (➞3-2)

Contrast list box (➞3-22) Color tone list box (➞3-22)

Saturation list box (➞3-22)

IPTC Information button
* Images shot on the EOS D60 are

not compatible with this function.

RGB value display
When you move the cursor over an
image, the coordinates of the
cursor position and its RGB values
(8-bit conversion) are shown here.
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Starting the Plug-In Module

Select Previous Image
button (➞3-12)

Select final image button (➞3-12)

Remove checkmark button
(➞3-14)

Camera Connection button (➞3-5)

Open Folder button (➞3-6)

Transfer Image button (➞3-32)

Save File button (➞3-23, 3-27)

Select button (➞3-16)

Erase button (➞3-17)

Exit button (➞3-2, 3-33)

Select first image button
(➞3-12)

Select image number input box
(➞3-12)

Show Version button

Checkmark button (➞3-14)

Protect button
(➞3-15)

Remove protect button (➞3-15)

Click white balance checkbox
(➞3-21)

Digital Exposure Compensation button
(➞3-19)

Click white balance button (➞3-21)

White balance list box (➞3-20)

When you install just the Plug-In Module without installing ImageBrowser, the “Could
not locate ImageBrowser” message appears when you connect the camera to your
computer. If this happens, click the [OK] button and then see “Disabling ImageBrowser
Auto Start” (➞8-4) and disable ImageBrowser auto start.

Select Next Image button
(➞3-12)

Play sound button
* Images shot on the EOS D60 are

not compatible with this function.
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Displaying Images
This section describes how to display images stored on a CF card.
You can display images via the interface cable while the CF card is still in the camera, or by
loading the CF card into a third party card reader.

Displaying Images by Connecting the Camera to Your Computer

1 Click the [Camera Connection] button.
\ After a short delay, the images

appear.
● The highest numbered image in

the highest numbered folder is
automatically selected and
displayed.

2 Select a folder that contains images.
● When you click a folder name in the select image folder display area, the images in

that folder are displayed. Click [All] to display all the images on the CF card.

● Because RAW images are processed before being displayed, there is a short
delay before the images appear.

● You can specify which image is selected first when the [Camera Connection]
button is clicked. (➞3-29)
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Displaying Images

Displaying Images by Connecting a Card Reader
Remove the CF card from the camera and load it into the card reader. (➞2-4)

1 Click the [Open Folder...] button.
\ The [Select Image Folder] dialog

box appears.

2 Select the image format.
● Select [Images in DCIM folder

(JPEG & RAW)].

3 Select a folder.
● Open the drive for the CF card

containing images shot on the
EOS D60 and select the [DCIM (or
Dcim)] folder.

4 Click the [Choose] button.
\ The images shot on the EOS D60 in the selected folder are displayed.
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Displaying Images

Image Display Formats
[Images in DCIM folder (JPEG&RAW)]
Use this option to display the JPEG and RAW images saved in the DCIM folder.
In step 3, you can also select any folder in the DCIM folder and display only the images saved
in that folder.
If you display images in this format, do not rename any of the folders on the CF card.
Renaming folders such as the DCIM folder or 100CANON folder may make it impossible to
display the images in those folders.

[RAW (*.TIF) images in any folder]
Use this option to display only the TIFF-format RAW images (EOS-1D etc.) saved in the
selected folder. Select this format in step 2, then select a folder containing TIFF-format RAW
images.

[RAW (*.CRW) images in any folder]
Use this option to display only the CRW-format RAW images (EOS D60 and D30 etc.) saved
in the selected folder. Select this format in step 2, then select a folder containing CRW-format
RAW images.

[JPEG (*.JPG) images in any folder]
Use this option to display only the JPEG images saved in the selected folder. Select this
format in step 2, then select a folder containing JPEG images.
Depending on the type of device that originally created the image, you may not be able to
display some JPEG images.

To save the images on a CF card to your computer or to another media, you must
select and then save the displayed images (➞3-23) or copy the DCIM folder to your
computer or to the target media.

● Because RAW images are processed before being displayed, there is a short delay
before the images appear.

● To display the images saved on your computer’s hard disk, use the procedure
described in “Displaying Images by Connecting a Card Reader” (➞3-6).
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Selecting the Image Display Format
The format options for image display are [All], [JPEG], [EOS D60 RAW] and [All EOS D60].
Specifying one of these options allows you to display only images in the selected format.

Click the [Image display format] list box and select the image
display format.
\ Only images in the selected

display format are displayed.

[All]
All the images saved in the selected folder are displayed.

[JPEG]
Only JPEG images are displayed.

[EOS D60 RAW]
Only EOS D60 RAW images are displayed.

[All EOS D60]
Only images shot on the EOS D60 in the RAW+JPEG images are displayed.

You may be unable to correctly display images that were shot on cameras other than the
EOS D60 or that were modified or renamed on a computer after being captured.

If the selected folder or the CF card in the connected camera contains any images
(including RAW or JPEG images) that were shot on a Canon camera other than an
EOS D60, the image display format for those images is displayed in the list box.
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Selecting the Display Mode and Display Size

Display number
Numbers are assigned sequentially
to the displayed images starting
with the first image.

Recording format
The [RAW] symbol is
displayed for RAW images.
No symbol is shown for JPEG
images.

Digital exposure
compensation (➞3-19)

File name or shooting date/time
The item selected in [Image Lower Display
Item] list box in the [Preferences] dialog box
(➞3-29) is displayed.

Checkmark (➞3-14)

Protect mark (➞3-15)
This mark is attached to
protected images.

Transferred image mark
(➞3-33)
This mark is attached to
images that have been
transferred to the Plug-In
Module-compatible
application.

The available display modes are [Thumbnail display], [Preview] and [JPEG Preview]. You can
select [Large], [Middle], or [Small] as the display size for each display mode.

Selecting the Display Mode

Click the [Display Mode] list box and select the mode.
\ The images are displayed in the

selected display mode.

[Thumbnail display]
This shows multiple images arranged in
sequence. The information shown below is
also displayed for the images.

When you start the Plug-In Module, images are always shown in the [Thumbnail
display] mode.
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Selecting the Display Mode and Display Size

[Preview]
The selected image is displayed as a single
frame.

[JPEG Preview]
JPEG image is displayed.
The table below shows the types of JPEG
images displayed for the different image
recording formats.

When a RAW image is shot on the EOS D60, a JPEG (Middle/Fine) image is recorded
at the same time. When you select [JPEG Preview] for an EOS D60 RAW image, the
JPEG (Middle/Fine) image included in the RAW image is displayed.

Recording Format

JPEG image

RAW image

Displayed JPEG Image

JPEG image

JPEG image
(Middle/Fine)
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Selecting the Display Mode and Display Size

Selecting the Display Size

Click the [Display Size] list box and select the display size.
\ The image is displayed in the

selected display size.

In the [Preview] mode, the available image sizes are [Large] (100%), [Middle] (50%)
and [Small] (25%).
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Selecting Images
Selecting Images with the Mouse

Position the mouse cursor over the image and click the mouse
button.
● To select multiple images at

random, hold down the <shift> key
and select the images.

● To select consecutive images,
select the first image and then
hold down the <option> + <shift>
keys and select the last image.

\ The frame around the selected
image changes color.

: [Select first image] button
Selects the first thumbnail image displayed.

: [Select Previous Image] button
Selects the image before the currently selected image.

: [Select image number] input box
Selects the image with the specified number. You can enter a number
between 1 and 9999. Enter the number and press the <return> key.

: [Select Next Image] button
Selects the next image.

: [Select final image] button
Selects the last thumbnail image displayed.

● If you position the mouse cursor over an image and double-click, the image is
transferred to Photoshop 5.0 LE (Plug-In Module-compatible application).

● To select an image using the keyboard, use the arrow keys (↑ ← → ↓) to move to
the image and then press the spacebar.

Selecting Images from the Control Panel

You can also select images in the image selection control panel.
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Working with Selected Images
Operations that Can Be Used with Images

The table below lists the operations available with the Plug-In Module. When a JPEG image is
selected, the unavailable operations are shown grayed out.

Image recording formats and image processing options

Operations

Checkmark

Protect

Erase

Comment input*

Transfer image

Save file

Rotate image*

Digital exposure
compensation

White balance

Click white balance

Contrast

Color saturation

Color tone

RAW

✓

✓

✓

✓

✓

✓

✓

✓

✓

✓

✓

✓

✓

JPEG

✓

✓

✓

✓

✓

✓

✓

–

–

–

–

–

–

Description

Used for selecting specific images.

Protects the image so it cannot be erased.

Erases unprotected images.

Attaches a brief comment to each frame.

Transfers images to applications such as
Photoshop 5.0 LE.

Saves an image to your computer, etc.

Rotates the image by 90 degree unit.

Adjusts the brightness.

Adjusts the white balance.

Automatically adjusts the white balance.

Adjusts the contrast.

Adjusts the color density.

Adjusts the color tone.

● Operations marked with an asterisk (*) cannot be used with images saved on a CF card in
the camera and are shown grayed out in the control panel. Save such images to your
computer or use the operation via a card reader.

The sharpness for RAW images can be specified in the [Preferences] dialog box
(➞3-29).
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Working with Selected Images

Attaching Checkmarks to Selected Images
You can use this function to attach checkmarks to your images for quick and easy image
selection. Note that attaching a checkmark to an image does not protect the image.

Click the [Checkmark] button.

\ When you attach a checkmark to an image, the [       ] appears.
● Clicking the [Remove checkmark]

button removes the [       ] and
cancels the checkmark setting.

A range of operations is also available by selecting the image, pressing the <control>
key + mouse button and selecting an option from the menu that appears.

The checkmark is removed when you quit the Plug-In Module.
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Working with Selected Images

Protecting Images
You can protect important images to prevent them from being accidentally erased.

Click the [Protect] button.

\ The image is protected, and the [      ] is displayed.
● Clicking the [Remove protect]

button clears the [      ] and
removes the protection.

● When multiple images are selected, all the selected images are protected.
● The [      ] is automatically displayed for images that were protected on the camera.
● Protection only prevents images from being erased. Other types of image

processing can still be specified for protected images.
● A range of operations is also available by selecting the image, pressing the

<control> key + mouse button and selecting an option from the menu that appears.
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Working with Selected Images

Selecting Images by Condition
This feature allows you to select multiple images for which a condition has been set (e.g.
checkmarked or protected images) in a single operation. You can also select all the displayed
images.

Click the [Select] button and select the condition from the menu
that appears.
\ Only images that meet the

condition are selected.

Image information display area
● Displays information such as the file name, camera model name and

shooting data. The number of items displayed differs depending on the
camera settings.

● Use the scroll buttons to display parts of the information that are not visible.
● When you select multiple images, the information from the image selected

last is displayed.
● You can copy the information as text data and paste it into another

application.

Comment input box
You can use this box to type in a comment up to 120 characters long.
Type in your comment and press the <return> key.

Checking the Image Information
Shooting information is recorded when images are taken. You can check the shooting
information by selecting the image.
Also, you can copy shooting information to paste it into another application, and you can add a
comment.



3-17

W
or

ki
ng

 w
ith

 Im
ag

es
 in

 th
e 

P
lu

g-
In

 M
od

ul
e

Working with Selected Images

Erasing Images
Use the procedure below to erase unwanted images from a CF card or your computer.

1 Click the [Erase] button.
\ An erase confirmation dialog box

appears.

● Erased images cannot be restored. Check carefully before erasing images.
● Protect important images to prevent them from being accidentally erased.
● If you click the [Erase] button when multiple images are selected, all the selected

images are erased. Take particular care when you have just finished a task
involving the selection of multiple images.

2 Click the [Erase] button.
\ The image is erased.

A range of operations is also available by selecting the image, pressing the <control>
key + mouse button and selecting an option from the menu that appears.

Rotating Images
Use the procedure below to rotate a selected image by 90 degree unit left or right.

Rotate the image.
● To rotate the image right

(clockwise), click the [Rotate right
90 degrees] button.

● To rotate the image left
(counterclockwise), click the
[Rotate left 90 degrees] button.

\ The image rotates 90 degrees in
the selected direction.

● When multiple images are selected, all the selected images are rotated.
● A range of operations is also available by selecting the image, pressing the

<control> key + mouse button and selecting an option from the menu that appears.
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Processing RAW Images
RAW images are processed so that they are optimized for their intended purpose. In addition
to the digital exposure compensation and white balance settings, the Plug-In Module allows
you to specify the click white balance, contrast, color density and color tone.
This image processing does not involve working with the original RAW images. It applies
virtual parameters to RAW images temporarily downloaded to the computer.
Accordingly, you can redo the processing repeatedly with different parameters.
You can also change the modified parameters back to the settings used when the shot was
taken.

1 Process the RAW image.
● Set the image display format to [EOS D60 RAW]. (➞3-8)
● Select the RAW image to be processed. (➞3-12)
● It is recommended that you use the [Preview] mode to check the processed image.

(➞3-10)

2 Change the parameter settings.
● Change parameter settings. See the pages that follow for information on how to set

the parameters.
\ The image is reprocessed using the modified parameters and the result is shown.
● Because the parameters set during shooting and the modified parameters for the

original RAW image are updated in realtime.

3 Save or transfer the image in a commonly used format.
● You can save an image as a JPEG or TIFF format by clicking the [Save File...]

button and selecting [Convert and save in file...] from the menu that appears
(➞3-23). By selecting [JPEG Extraction...], you can extract and save a JPEG image
(Middle/Fine) from an image recorded in the RAW format (➞3-27).

● Clicking the [Transfer Image] button transfers the image to Photoshop 5.0 LE.
(➞3-32) You can specify the number of colors when the image is transferred in the
[RAW Image Processing Settings] tab sheet in the [Preferences] dialog box
(➞3-30).

● When multiple images are selected, the specified processing is applied to all the
RAW images selected.

● The sharpness for RAW images can be specified in the [Preferences] dialog box
(➞3-29).
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Processing RAW Images

2 Correct the image brightness.
● Adjust the image brightness by

using the mouse to drag the slider
left or right.

● When you click the [Preview]
button, the image brightness
changes according to the value of
the new slider position.

3 Click the [OK] button.
\ The corrected value is applied to

the image and the [Digital
Exposure Compensation] dialog
box closes.

\ The corrected value is displayed
with the corrected image.

Correcting the Brightness (Digital Exposure Compensation)
You can correct the brightness of an image through the equivalent of ±2 stops in 0.1-stop
increments.

1 Click the [Digital Exposure Compensation] button.
\ The [Digital Exposure

Compensation] dialog box
appears.
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Processing RAW Images

Adjusting the White Balance
You can adjust the white balance in your RAW images.
You can select the white balance from the 8 available settings. You can also make finer
adjustments to the white balance using the Click White Balance function, which allows you to
adjust the balance by selecting a white area in the image.

Select the White Balance

Select the white balance from the [White balance] list box.
● The table below shows the 8

available white balance settings.
● [White Point] is displayed only

when you select an image that has
been adjusted using the Click
White Balance function.

White Balance

Shot Settings

Auto

Daylight

Cloudy

Tungsten

Fluorescent

Flash

White Point

Details

Select this option to apply the white balance
setting used when the shot was taken.

The Plug-In Module automatically adjusts the
white balance

Select this setting for shots taken outdoors in
sunny weather.

Select this setting for shots taken outdoors in
cloudy weather or in shade, at dusk and for shots
of sunsets.

Select this setting for shots taken in incandescent
white lighting.

Select this setting for shots taken in fluorescent
white lighting.

Select this setting for shots taken using a flash.

Displayed when you use Click White Balance.
(➞3-21)

Color temp./K (Kelvin)

–

Approx. 3000-7000

Approx. 5200

Approx. 6000

Approx. 3200

Approx. 4000

Approx. 6000

Approx. 2000-10000

\ The adjusted image appears.
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Processing RAW Images

Click White Balance Function
This function allows you to automatically adjust the white balance simply by clicking a point in
a white part of the image.

1 Click the [Click white balance] checkbox.
\ The [Click white balance] button is

now enabled.

2 Select a white area.
● When you move the cursor over the image, it changes to the shape of a filler.
● Click in a white area in the image.

\ The white balance is adjusted so that the area clicked appears white and the result
in displayed.

● To adjust the white balance using a different location, click the [Click white balance]
button again.

● To end the Click White Balance procedure, click the checkbox again to clear the
box and end the procedure.
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Adjusting the Color in Images
Use the procedures below to adjust the color parameters (contrast, color density and color tone)
in images. You can adjust the color by selecting settings from the respective list boxes.

Adjusting the Contrast

Select the desired contrast from the [Contrast] list box.
\ The resulting image is displayed.

Adjusting the Color Density

Select the desired color density from the [Saturation] list box.
\ The resulting image is displayed.

Adjusting the Color Tone

Select the desired color tone from the [Color tone] list box.
\ The resulting image is displayed.
● [Color tone 1] adjusts the colors so

that the red tones are stronger.
[Standard] applies the standard
color matching adjustment.
[Color tone 2] adjusts the colors so
that the yellow tones are stronger.
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Saving Images
This section explains how to use the interface cable to save images stored on a CF card in
your camera onto your computer. This section also describes a simple method for creating
JPEG images from RAW images.

Saving Images from the Camera to Your Computer
You should save the images you have shot on your computer.

1 Select the images.
● To save the images to separate folders, click the folder name in the select image

folder display area and then select the images to be saved.
● To gather images in different folders together and save them in the same folder,

click [All] in the select image folder display area and then select the images to be
saved.

● Only the images with colored frames are saved.
● See “Selecting Images” (➞3-12) for information on how to select images.

2 Click the [Save File...] button and select [Convert and save in
file...].
\ The [Save File] dialog box

appears.

3 Select a folder.
● Click the [Browse] button.
\ The [Choose a Folder] dialog box appears.
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Saving Images

● Select the folder that the images
will be saved in and click the
[Choose] button.

\ Clicking the [New] button opens
the [New Folder] dialog box.

● You can create a new folder inside
the selected folder by entering the
folder name and clicking the
[Create] button.

4 Set the save options and click the [OK] button.
\ The images are saved in the selected folder.

A range of operations is also available by selecting the image, pressing the <control>
key + mouse button and selecting an option from the menu that appears.
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Saving Images

1

3

2

10

9

5

1 The converted image is saved in the same folder as the displayed image. You cannot
select this option for images that are saved on a CF card in the camera. This option is
only available for images saved on your computer or on a CF card in a card reader.

2 Use this button when you want to specify the folder in which the image will be saved.

3 When the [Save in following specified folder.] radio button is selected, this button
specifies the folder in which the image will be saved.

4 Shows the folder in which the image will be saved.

8

7

6

11

12

4

Save File dialog box
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Conversion Format

Do Not Convert

Exif-JPEG

Exif-TIFF(8bit/ch)

TIFF(16bit/ch)

File Extension

_.CRW

_RJ.JPG

_RT8.TIF

_RT16.TIF

5 Select this option when the images to be saved include RAW images.
Select [Do Not Convert], [Exif-JPEG], [Exif-TIFF(8bit/ch)] or [TIFF(16bit/ch)].
The file extensions used for the saved files are shown below.

● The Plug-In Module cannot display images converted to TIFF format (Exif-TIFF(8bit/
ch) or TIFF(16bit/ch)) and saved.

● To use linear processing, specify linear processing in the [Preferences] dialog box
(➞3-29) and select [TIFF(16bit/ch)] when you save the image. Even when linear
processing is specified, linear processing cannot be applied to images saved in
[Exif-TIFF(8bit/ch)] format.

6 You can specify the [Compression Ratio] (image quality) when you select [Exif-JPEG]
from the [Convert from RAW to other format] list box. You can select from 4 compression
ratios-[4 (Highest Image Quality)] to [1 (High Compression Ratio)]. The higher the value,
the higher the quality of the JPEG image.

7 This checkbox is enabled when you select [Do Not Convert] in the [Convert from RAW to
other format] list box. Click this checkbox when you want to save the RAW image
without changing the name.

8 This is text inserted before the file number for sorting. You can enter up to 12 characters.
When you enter text, an example of the file name appears in the [Example] field below
the text box.

9 You can specify up to 9 digits in the file number.

10 Specifies the first file number.

11 This function is not compatible with images shot on the EOS D60.

12 This function is not compatible with images shot on the EOS D60.
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Saving Images

Extracting JPEG Images from RAW Images
When a RAW image is shot on the EOS D60, a JPEG (Middle/Fine) image is recorded at the
same time. You can save the JPEG (Middle/Fine) image included with an EOS D60 RAW
image to your computer by extracting the JPEG image from the RAW image.

1 Select the RAW image from which a JPEG image is to be
extracted.
● Set the image display format to [EOS D60 RAW] (➞3-8) and select the RAW image

from which you want to extract a JPEG image. (➞3-12)

2 Click the [Save File...] button and select [JPEG Extraction...] from
the menu that appears.
\ The [JPEG Extract] dialog box

appears.

3 Specify the desired settings and click the [OK] button.
\ The JPEG image is saved in the selected folder.
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1

7

8

1 The converted image is saved in the same folder as the displayed image. You cannot
select this option for images that are saved on a CF card in the camera. This option is only
available for images saved on your computer or on a CF card in a card reader.

2 Use this button when you want to specify the folder in which the image will be saved.

3 When the [Save in following specified folder.] radio button is selected, this button specifies
the folder in which the image will be saved.

4 Shows the folder in which the image will be saved.

5 Click this checkbox when you want to save the RAW image without changing the name.

6 This is text inserted before the file number for sorting. You can enter up to 12 characters.
When you enter text, an example of the file name appears in the [Example] field below the
text box.

7 You can specify up to 9 digits in the file number.

8 Specifies the first file number.

2

3

5

4

6

JPEG Extract dialog box
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Specifying the Preferences
You can use the procedure below to specify the general settings for the Plug-In Module and
the processing method for RAW images.

1 Click the [Preferences] button.
\ The [Preferences] dialog box

appears.

1

2

3

4

General Settings tab sheet

2 Select the [General Settings] tab or the [RAW Image Processing
Settings] tab.
\ The selected tab sheet appears.

3 Specify the desired settings.
● Select the desired option in each setting.

4 Click the [OK] button.
\ The settings are applied and the [Preferences] dialog box closes to end the

procedure.
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Specifying the Preferences

● You can specify the settings shown below in the [General Settings] tab
sheet.

1 When you click the [Camera Connection] button, the highest numbered image in the
highest numbered folder in the DCIM folder is displayed.
When this checkbox is not checked, the lowest numbered image in the lowest numbered
folder is displayed.

2 Select [File Name] or [Shooting Date/Time] as the information displayed below images.

3 Select [inch] or [cm] as the units used in the Plug-In Module.

4 Sets the resolution used when images are transferred to a Plug-In Module-compatible
application such as Photoshop 5.0 LE. You can specify values between 50 and 2400
pixels for [inch] and between 20 and 944 pixels for [cm].

10

9

7

8

11

6

12

13

5

RAW Image Processing Settings tab sheet
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Specifying the Preferences

● You can specify the settings shown below in the [RAW Image Processing
Settings] tab sheet.
The settings described here are those shown when [EOS D60] is selected in the [Model
Name] list box.

5 Select [EOS D60].

6 Set the sharpness setting to [Shot Settings], [OFF], [Low], [Standard] or [High].

7 When you click this checkbox, linear tone curve adjustment is performed on the image.
This option minimizes the image degradation that occurs during the tone curve
adjustment made when the image is transferred to an application such as Photoshop 5.0
LE, since the adjustment is linear. Select this option when you want to make fine color
adjustments independently. Also, when you transfer or save an image for which linear
processing has been specified, select [16 bits per color channel] in [Transferring images
to application] and select [TIFF(16bit/ch)] in the [Convert from RAW to other format] list
box (➞3-25, 3-26) in the [Save File] dialog box.

8 Clicking this checkbox neutralizes false colors.

9 When you click this checkbox, a 16% reduced image is shown in the [Preview] mode.

10 Select [8 bits per color channel] or [16 bits per color channel] as the transfer bit rate to
the Plug-In Module-compatible application. Note that when [16 bits per color channel] is
selected, images are only transferred as 16-bit images if the software supports 16-bit
images.

● The buttons listed below are displayed in each of the tab sheets. They
function in the same way in each sheet.

11 Restores the default settings for all the parameters in the currently displayed tab sheet.

12 Discards all the settings, restores the parameters to their original values and ends the
procedure.

13 Applies the specified parameters, closes the [Preferences] dialog box and ends the
procedure.

When [EOS-1D], [EOS D30], [PowerShot G1], [PowerShot G2], [PowerShot Pro90 IS],
[PowerShot S30] or [PowerShot S40] is selected in the [Model Name] list box, the
available settings for the respective camera model are displayed.
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Transferring Images to Photoshop 5.0 LE
Use the procedure below to transfer images displayed by the Plug-In Module to Photoshop 5.0
LE (Plug-In Module-compatible application).

1 Select the transfer mode from the [Image transfer mode] list box.
● There are 2 available transfer

modes.
[Single-Frame Transfer]:
The selected images are
transferred as an individual image.
[Transfer as Index Image]:
Thumbnails are created for the
selected images and transferred
as an index sheet.

2 Click the [Transfer Image] button.
\ If you selected [Transfer as Index

Image] in the [Image transfer
mode] list box, the [Index Sheet
Transfer Options] dialog box
appears.

1 Enter the width of the index sheet to be created.
2 Enter the height of the index sheet to be created.
3 Enter the resolution of the index images.
4 Indicates the projected image file size based on the specified width, height and

resolution.
5 Cancels the index sheet transfer options settings.
6 Applies the specified settings, closes the [Index Sheet Transfer Options] dialog box and

starts index sheet transfer.

1

2

3

4

5 6
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Transferring Images to Photoshop 5.0 LE

3 Enter the settings and click the [OK] button.
\ The [Transfer Images] dialog box

appears and the progress of
transferring is displayed.

● You can stop image transferring by
pressing the [Cancel] button.

\ The transferred image is displayed in Photoshop 5.0 LE.
\ The [       ] is displayed for transferred images. (➞3-9)
● Click the [Exit] button in the main window to exit the Plug-In Module.
● Display an image transferred with [Single-Frame Transfer].



3-34

Transferring Images to Photoshop 5.0 LE

● Display images transferred with [Transfer as Index Image].

● When you select RAW images and transfer the images as index images, the RAW
image processing settings specified in the Plug-In Module are not reflected in the
transferred images.

● When you want to transfer a single frame, you can also transfer the image by
simply positioning the mouse cursor over the image and double-clicking.

● A range of operations is also available by selecting the image, pressing the
<control> key + mouse button and selecting an option from the menu that appears.

● You can modify the transfer resolution setting in the [General Settings] tab sheet in
the [Preferences] dialog box. (➞3-29)



This chapter describes the settings needed to enable the USB Mounter
and explains how to download and process RAW images with the USB
Mounter.

Downloading Images with
the USB Mounter

4
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Using the USB Mounter
The USB Mounter is a driver that allows images on a CF card in a camera to be displayed on the
computer screen as if the camera were a drive or a connected card reader. Images can be
downloaded to the computer with the same procedures used to save images from a card reader.

Enabling the USB Mounter
To download images with the USB Mounter, first enable it with the following procedures.

1 Select the Apple menu     s [Control Panels] s [Canon USB
Camera Driver].
\ The [Canon USB Camera Driver] dialog box appears.

2 Select the [Card Reader Mode] radio button and then close the
[Canon USB Camera Driver] dialog box.
\ A dialog box prompting you to

restart the computer appears.

3 Click the [Yes] button to restart the computer.
\ The USB Mounter will be enabled.

How to Disable the USB Mounter
Disable the USB Mounter when you need to upload images to the camera or shoot with
RemoteCapture. Select the Apple menu     s [Control Panels] s [Canon USB Camera Driver]
and then select the [Camera mode] radio button. After you restart the computer, the USB
Mounter will be disabled.

● You cannot use USB Mounter when the LCD monitor is switched on. Likewise, you
cannot operate the camera while you are using USB Mounter.

● To enable the USB Mounter, the camera must be handled as if it were a drive like a
card reader. Consequently, the following cannot be performed while the USB
Mounter is running.
• ImageBrowser cannot be automatically started when you connect the camera to

your computer.
•Y ou cannot open a connection to ImageBrowser or the Plug-In Module and adjust

camera settings.
•Y ou cannot shoot with RemoteCapture.
In addition, images cannot be deleted from the camera and the computer images
cannot be uploaded to the camera.

Click here to close it.
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Using the USB Mounter

Downloading Images

1 Connect the camera to your computer.
● For more information on connecting the camera to your computer, see “Connecting

the Camera to Your Computer” (➞2-2).
\ The camera icon appears on the desktop.

2 Double-click the camera icon.

3 Select the folder containing the images.
\ The images on the CF card appear as file icons.
● See “CF Card Folder Structure and File Names” (➞2-4) for more information on the

CF card folder structure.

4 Download images to the computer’s hard disk using standard file
saving procedures.
● Select images and drag and drop them onto the target folder on the computer to

download them.

Never turn off the power or detach the interface cable while downloading. The
equipment may not operate correctly.

Camera icon
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How to Download Images from ImageBrowser and the
Plug-In Module while the USB Mounter is Enabled
When the USB Mounter is enabled, use the card reader downloading procedures in
ImageBrowser or the Plug-In Module to download from the camera.
To download images using ImageBrowser, start up ImageBrowser by double-clicking its icon
(➞8-4) and then see “Downloading and Saving Images” (➞8-7).
To download images using the Plug-In Module, start up the Plug-In Module (➞3-2) and then
see “Displaying Images by Connecting a Card Reader” (➞3-6) and “Saving Images” (➞3-23).

How to Process RAW Images while the USB Mounter is
Enabled
To convert RAW images when you are using the USB Mounter, start up RAW Image
Converter, download the RAW images on the camera and then click the [Convert and save by
current settings...] button and process the images. See “Using RAW Image Converter” (➞5-2)
for more information on how to use RAW Image Converter.



This chapter describes how to use RAW Image Converter to display
images that you have saved onto your computer or onto a CF card
inserted into a third-party card reader, and how to process and image-
process those RAW images.

Working with Images in
RAW Image Converter

5
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Using RAW Image Converter
When you use the USB Mounter or copy images directly from a card reader, you can use RAW
Image Converter to display and process images in the same way as the Plug-In Module. You
can also save the processed images in JPEG or TIFF (8 or 16 bits/channel) format.

1 Start RAW Image Converter.
● [Canon Utilities] folder s [RAW Image Converter] folder s double-click [RAW

Image Converter] to start.
\ The [RAW Image Converter] main window appears.

RAW Image Converter main window

Deletes images
from the list of
RAW images.

Displays the list
of RAW images.

Adds images to the
list of RAW images.

When all the
images are
selected, displays
[Save File] dialog
box in the Plug-In
Module.

With all the images selected, the Plug-In Module
[JPEG Extraction] dialog box appears.

Displays all the
images shown in the
RAW image list in
the Plug-In Module
main window.

Quits RAW Image
Converter.

The Plug-In Module
[Preferences]
dialog box (➞3-29)
appears.
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Using RAW Image Converter

2 Download the images.
● Click the [Add RAW Image] button,

select an image from the [Open:
RAW Image Converter] dialog box,
click the [Open] button and add
the RAW image to the image list.

\ The RAW images are added to the
image list.

3 Image-process and save the images.

● When you click the [Convert and save by current settings...] button and all the RAW
images displayed in the image list are selected, the Plug-In Module’s [Save File]
dialog box (➞3-25) appears. Use this dialog box to process and save the images.

● When you click the [List for Development Condition Settings...] button, all the RAW
images shown in the image list are displayed as thumbnails in the Plug-In Module’s
main window (➞3-3). Use this window to process and image-process the images.

● When you click the [Extract and save JPEG...] button, the Plug-In Module’s [JPEG
Extraction] dialog box (➞3-28) appears. Use this dialog box to save just the JPEG
images contained in the selected folder.
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Using RAW Image Converter

4 Click the [Quit] button.

● For more information on using the windows and dialog boxes that appear, see
Chapter 3, “Working with Images in the Plug-In Module”.

● When you display the Plug-In Module’s main window from RAW Image Converter,
the [Camera Settings] button, [Camera Connection] button, [Transfer Image] button,
[Erase] button and [Image transfer mode] list box are not shown. To perform tasks
such as downloading images from the camera, start the Plug-In Module from
Photoshop 5.0 LE.

● When you click the [List for Development Condition Settings...] button and the
[Save File] dialog box appears, the [Do Not Convert] option in the [Convert from
RAW to other format] list box is not available.



This chapter provides information on camera settings such as the owner
name, date and time.

Specifying Camera Settings
from Your Computer

6
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Specifying the Camera Settings
Use the procedure described here to apply the owner name and date/time settings to the
camera. The owner name, and date and time that were applied on the camera are recorded
with the images.
You can also format (initialize) CF cards and check the camera properties data and the status
of the battery and the CF card.

Display the [Camera Settings] dialog box.
● To display this dialog box from the

Plug-In Module, click the [Camera
Settings] button in the main
window.

● To display this dialog box from
ImageBrowser, select [Canon
Camera] menu s [Settings] s
[Camera Settings...] in the Camera
window.

● To display this dialog box from
RemoteCapture, select [Camera
Setting...] from the [File] menu.

\ The [Camera Settings] dialog box appears.
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Specifying the Camera Settings

Basic Settings tab sheet

This box shows the Camera’s model name,
Body ID and Firmware Version.

These fields set the
camera owner and
the date and time.
You can enter up to
31 characters in
[Owner’s Name].

[OK] indicates that there is
ample remaining charge in the
battery and [LOW] indicates
that the battery charge is low.
[AC] is displayed when you
are running the camera from a
household power supply.

This box shows
whether a CF card is
loaded in the camera
along with the
available space on
the card and its total
capacity. You can
also format a CF
card from this box.

Applies the specified settings,
closes the [Camera Settings] dialog
box and ends the procedure.

Discards all the settings, restores
the parameters to their original
values and ends the procedure.

Applies the settings.

Formatting (initializing) a CF card erases all the data on the card. Because formatting
also erases protected images, you should check the data recorded on the card
carefully before proceeding.

Camera Settings dialog box
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Specifying the Camera Settings

Setting the Owner’s Name, Date and Time

1 Enter the Owner’s Name.
● Type in the name from your keyboard. You can enter up to 31 characters.

2 Set the Date and Time.
● You can use the [    ] and [    ] buttons to set the Date and Time, or you can select a

field and enter the desired date or time from the keyboard. Clicking the [from Mac]
button imports the Date and Time data from your computer.

3 Click the [OK] button.
\ The owner’s name, date and time settings are applied to the camera.
● Once you click the [Apply] button, the settings remain effective until you reset the

owner’s name, date or time.
● Clicking the [OK] button applies the specified settings, closes the [Camera Settings]

dialog box and ends the procedure.



This chapter describes EOS D60 operations using the RemoteCapture
software, such as remote shooting, timer shooting and interval timer
shooting.

Operating the Camera from
Your Computer

7
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Starting RemoteCapture

1 Double-click the [Canon Utilities] folder s the [RemoteCapture]
folder s [RemoteCapture] to start.
\ A message appears prompting you to connect the camera to your computer.

2 Click the [Connect] button.
\ The Save window and Shooting

window appear.

● To quit RemoteCapture, click the [Disconnect] button and select [Exit] from the
[File] menu.

When you are using mirror lockup to take pictures, there is a delay of approximately 2
seconds after you click the RemoteCapture [Release] button before the picture is
actually taken.

Selecting [Camera Setting...] from the [File] menu allows you to specify the camera
settings. For information on how to specify the camera settings, see Chapter 6
“Specifying Camera Settings from Your Computer”.
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Starting RemoteCapture

Image display area
Displays the image selected in the thumbnail view.

Histogram
Shows the distribution
of brightness values.

Image Information
Allows you to check the
image information details.

Comment input box
Use this field to type in a comment for the image.

Thumbnail view
Displays thumbnail
images of the shots taken.

Delete button
Deletes the image selected in thumbnail view. Deleted
images are completely removed from your computer.
Check images carefully before deleting them.

View button
Displays the image selected in thumbnail
view enlarged in a separate window.

Disconnect button
Cuts the connection to
the camera.

Save window

Shots to Go
This box displays the
number of frames that can
be saved on your
computer or on the CF
card in the camera.

Release button
Takes a shot with the
camera. The image is
automatically saved on your
computer. Even when you
press the shutter button on
the camera, the image is
saved on your computer.

Rotation list box

Shooting window

Rotate the image to be shot
90 degrees left or right.

The [RAW] symbol is
displayed for RAW
images.
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Taking Shots from Your Computer
You can control the camera from your computer and take single-frame shots, timer shots and
interval timer shots. The images are automatically saved on your computer.
Shots taken with RemoteCapture and saved on your computer can be displayed and image-
processed in the Plug-In Module in the same way as images shot with the camera.
Refer to the Help file for more information on using RemoteCapture.

Using RemoteCapture

1 Set the camera up ready to take pictures.
● Focus the camera manually (Manual focus).

2 Click the [Release] button.
\The image is saved to your computer and displayed on the screen.

● Because RAW images are processed before being displayed, there is a short delay
before the images appear.

● When you select an EOS D60 RAW image and click the [View] button, or when you
select [Display in Viewer] in the [View] menu, the JPEG image (Middle/Fine)
simultaneously recorded with the RAW image is displayed.

● To load an image rotated, select [90 degrees Right] or [90 degrees Left] in
[Rotation] list box before clicking the [Release] button.

● To rotate a downloaded image, select the image and then select [Rotate Saved Image
90 degrees Right] or [Rotate Saved Image 90 degrees Left] in the [Edit] menu.

● To enlarge the image for checking, select the image and click the [View] button.
\ The image is displayed enlarged in a separate window.
● To delete the image, select the image and click the [Delete] button.
\ The image is deleted.
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Taking Shots from Your Computer

Default Settings
Use the procedure below to select the folder in which images will be saved and to specify the
file names.

1 Select [Preferences...] in the [File] menu.
\ The [Preferences] dialog box appears.

2 Select the save destination in which images will be saved.
● Click the [Computer only] or [CF

card first, then computer] radio
button.

● [Computer only]
This option allows you to take shots when there is no CF card in the camera or
when the CF card is full.

● [CF card first, then computer]
This option saves the images both on your computer and on the CF card in the
camera.

Preferences dialog box
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Taking Shots from Your Computer

3 Enter the file name to be used when images are saved.

● If you enter [Capture], sequential file names will be assigned automatically
beginning with [Capture_0001.jpg] or [Capture_0001.tif].

● File names can include up to 16 characters.

4 Select the folder in which the images will be saved.
● Click the [Select a Folder...]

button.
\ The [Select a Folder] dialog box

appears.

● Select the folder in which the
images will be saved and click the
[Choose] button.

● To create a new folder in which to
save images, click the [New]
button to create a new folder
inside the current folder.

\ The path for the selected folder
appears in the [Folder to which
lmages are Downloaded] field.

5 Click the [OK] button.
\ The settings are saved and the [Preferences] dialog box closes to end the

procedure.

You can set the Hotkey for shutter release by selecting the [Release Hotkey] tab.
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Taking Shots from Your Computer

Printing Images
You can print images. All the images shown in the thumbnail view are printed in index format.
The time of shooting and the file names are printed with the images.

1 Select [Print Index...] in the [File] menu.
\ The [Printer Setup] dialog box appears.

2 Select the printer to be used, specify the print settings and click
the [OK] button.
\ The images are printed.

Timer Shooting
Use this function to specify the timer delay. Timer shooting shots are then taken after the
specified number of seconds.

1 Select [Timer Shooting...] in the [File] menu.
\ The [Timer Shooting] dialog box appears.

2 Enter a number of seconds and click the [Start] button.
● You can set a value between 2

and 30 seconds in 1-second
increments.

\ Timer shooting are taken after the
specified number of seconds.
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Taking Shots from Your Computer

Interval Timer Shooting
This function allows you to specify the interval between shots and the number of shots.

1 Select [Interval Timer Shooting...] in the [File] menu.
\ The Interval Timer Shooting warnings dialog box appears.

2 Check the information in the warnings and then click the [Yes]
button.
\ The [Interval Timer Shooting] dialog box appears.

3 Enter the shooting interval and the number of shots, and then
click the [Start] button.
● You can set a shooting interval

between 5 seconds and 60
minutes in 1-second increments.

● You can set up to a maximum of
9999 shots.

\ Interval timer shooting is
performed using the specified
interval between shots and the
specified number of shots.

On some types of computer, if you set a short interval between shots and there is
insufficient time to download and save the images, it may not be possible to take shots
at the specified interval. If this occurs, set a longer interval between shots and take the
shots again.

Depending on the available capacity on your computer’s hard disk, the maximum
number of available shots that can be set may be less than 9999. You can check the
number of shots that can be set by referring to the number of available shots shown in
the Shooting window. (➞7-3)



This chapter explains how to use ImageBrowser to perform a range of
operations from downloading the camera’s images to printing them.

Working with Images in
ImageBrowser

8
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Starting ImageBrowser
You can start up ImageBrowser either from the [ImageBrowser Automation wizard] dialog box
that appears when you connect the camera to your computer, or by double-clicking the
ImageBrowser icon.

Starting ImageBrowser from the [ImageBrowser
Automation wizard] Dialog Box

When you connect the camera to your computer, start up ImageBrowser from the
[ImageBrowser Automation wizard] dialog box.

1 Connect the camera to your computer.
● For more information on connecting the camera to your computer, see “Connecting

the Camera to Your Computer” (➞2-2).
\ The [ImageBrowser Automation wizard] dialog box appears.

2 Confirm that [Display Images] radio button is selected and click
the [OK] button.
\ The [Communication Settings]

dialog box appears.

3 Confirm that [USB Port] is selected in the [Port] list box and that
[EOS D60] is selected in the [Detected Camera] list box, then click
the [Set] button.
\ The Camera window and Browser

window appear.
● The [Communication Settings]

dialog box only appears the first
time the camera is connected.

To set up the software so that ImageBrowser does not start up when you connect the
camera to your computer, see “Disabling ImageBrowser Auto Start” (➞8-4).
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Starting ImageBrowser

\ When you click the [Settings change] button, the window changes as shown below.

What to Do the Next Time ImageBrowser is Started
The automatic processing settings selected previously are displayed in the [ImageBrowser
Automation wizard] dialog box. To use these settings unchanged, click the [Start] button. To do
nothing, click the [Cancel] button. To change the settings, click the [Settings change] button.

For more information on using the [ImageBrowser Automation wizard] dialog box, refer
to the ImageBrowser Help menu or PDF manual, ImageBrowser Software User’s Guide.

● When the [Display Images] radio button is selected, click the [OK] button.
\ The Camera window appears.
● When the [Download images] radio button is selected, click the [Next] button and

then proceed as instructed by the on-screen messages.
\ The images on the camera are downloaded.
● When you select the [Launch RemoteCapture] radio button, click the [OK] button.
\ RemoteCapture (➞7-2) starts up.
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Starting ImageBrowser Using the Icon
When automatic ImageBrowser startup has been disabled, or when you want to download
images from a folder on your computer or from a card reader without connecting the camera to
your computer, use the [Canon ImageBrowser] icon to start ImageBrowser.

Double-click the [Canon ImageBrowser] icon.
● Double-click the [Canon

ImageBrowser] icon on the
desktop or the [Canon Utilities]
folder s [ImageBrowser] folder s
[ImageBrowser] icon.

\ The Browser window appears.

Disabling ImageBrowser Auto Start
Use the procedure below to set up your software so that ImageBrowser does not start up
automatically when you connect the camera to your computer.

1 Select the Apple menu     s [Control Panels] s [Canon
ImageBrowser Auto Launch].
\ The [Settings for USB connection] dialog box appears.

2 Uncheck the [The application program below will start.] checkbox.

3 Close the [Settings for USB connection] dialog box.
● Click the close box     at the upper left of the dialog box. The [Settings for USB

connection] dialog box will close.
\ ImageBrowser will cease to start automatically thereafter.
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The ImageBrowser Window

Explorer View Section
The [RAW] symbol is
displayed for RAW images. Browser area

When you start ImageBrowser, the Browser window appears. Then, when the connection to
the camera opens, the Camera window appears.

For more information on using ImageBrowser, refer to the ImageBrowser Help menu
or PDF manual, ImageBrowser Software User’s Guide.

Browser window

Click here to connect to
the camera.

Click here to select all the images.

Click here to delete images.

Click here to print
images.

Click here to display images.

Click here to enlarge or reduce images.
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The ImageBrowser Window

Saves images from the computer
onto the CF card in the camera.

An image of the connected camera
or CF card will be displayed here. Thumbnail

Sets various camera
settings. See
“Specifying the
Camera Settings”
(➞6-2) for
information on how to
specify the settings.

Downloads the selected images onto the
computer.

Camera window
The [RAW] symbol is displayed
for RAW images.

Lets you edit
the slide show
and DPOF print
specifications.

Displays the shooting data.

Rotates images displayed as thumbnails.

Click here to print images.

Reconnects the camera
to your computer.

Lets you choose the
image selection method.

Click here to delete images.
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Downloading and Saving Images
The procedure below describes how to download and save images from a CF card loaded in
the camera or in a card reader.

1 Display the images.
● To display the images on the

camera, click the [CANON
CAMERA] button.

● If ImageBrowser started up
automatically, the [ImageBrowser
Automation wizard] dialog box
appears. If you click the [Settings
change] button, select the [Display
Images] radio button and then
click the [OK] button, the images
on the camera automatically
appear in the Camera window.

\ In the Camera window, the images
on the camera are displayed as
thumbnails (reduced images).

● To display the images from a card
reader, double-click the [DCIM]
folder in the Explorer View
Section.

\ The images from the CF card will
be displayed as thumbnails in the
Camera window.

2 Create a new folder in which to save the images stored on the
camera.
● In the Explorer View Section,

choose the location where you
want to create the new folder and
then select [New Folder] in the
[File] menu.

\ A new folder is created.
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Downloading and Saving Images

3 Type in the folder name.
● Once you have typed in the folder

name, leave the folder selected.

4 Select the images you wish to download from the Camera
window and click the [DOWNLOAD] button.
● Click a thumbnail to select the corresponding image.

\ Downloaded images are saved to the computer and appear in the Browser area.

● You can also download images to the computer by dragging them from the Camera
window and dropping them on the Browser area or Explorer View Section.

● To disconnect the camera, click the close box     at the upper left of the Camera
window. The Camera window will close.
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Processing RAW Images with ImageBrowser
To process RAW images in the ImageBrowser, start from RAW Image Converter.

1 Select a RAW image.
● Select a RAW image from the Browser area of ImageBrowser.

2 Click the [File] menu and select [RAW Image processing...].
\ The RAW Image Converter main window appears.

3 Click the [List for Development Condition Settings...] button.
\ The RAW image appears as a thumbnail image in the Plug-In Module main window.
● See “Processing RAW Images” (➞3-18) for information on how to process RAW

images.

For more information on using the RAW Image Converter, see “Using RAW Image
Converter” (➞5-2).
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Merging Panoramic Images with PhotoStitch
You can merge a series of overlapping images into a single, seamless panorama.

Select the JPEG images in the Browser window, click the [Edit]
menu and select [PhotoStitch...].
\ PhotoStitch starts up.
● Follow the instructions in the guidance window to merge the images.
● Please refer to the PhotoStitch Help menu for more details.

You cannot open RAW images in PhotoStitch.

Follow the
instructions to merge
the images.
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Printing Images
1 Select the image(s) you wish to print.

2 Click the [PRINT] button and select [Layout printing...] from the
displayed menu.

3 Select a layout and click the [Next] button.
● Select the [Custom layout printing] radio button for the purposes of this example.

4 In the next dialog box, select a paper size and click the [OK]
button.
\ The [Layout Options] dialog box will close and the Print window will open, allowing

you to change the layout and printing settings.
● If you wish to change the layout, set the printing settings in the Print window.

5 Click the [PRINT] button in the Print window.
\ The [Print] dialog box appears.

Layout Options dialog box

Print window
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Printing Images

6 Click the [PRINT] button.
\ The images are printed.

Print window
When the [Custom layout printing] radio button is selected in the [Layout Options] dialog box,
you can freely change the size and position of the images for printing.

Displays the [Layout Options]
dialog box.

Displays the [PRINT]
dialog box.

Change the Layout
Drag the images to
change the layout.

Edit the Page Title
Open the [Edit] menu and
select [Edit Header].

Add Captions to Images
Click the image and then
select [Edit caption] from
the [Edit] menu.

Change the Image
Size
Drag the border to
resize the image.

Rotates the selected image.

Resets the layout.

Changes the default number of
images printed per page.

● The [Custom layout printing] radio button in the [Layout Options] dialog box allows
you to freely change the size and position of the images for printing. The other
options allow you to print an index or print onto Canon perforated paper. For more
details on the [Layout Options] dialog box, refer to the PDF manual, ImageBrowser
Software User’s Guide.

● The settings available in step 3 vary depending on type of printing selected in step 2.

Add Text
Open the [Edit] menu and
select [Add Text].
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This chapter provides a troubleshooting manual and describes the
software uninstallation procedures.

Troubleshooting and
Uninstallation
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Troubleshooting
When the “Could not complete installation correctly” or “Communication between the camera
and computer failed” message appears, check the items described below.

I have installed the EOS D60 software but the camera
and computer cannot communicate.

● Are you using the following type of computer?
➞ A Macintosh computer with a USB connector as a standard feature.

(* A Macintosh computer does not support USB connections that are not a standard
feature of the computer.)

● Are the camera and your computer connected correctly?
➞ Connect the camera to your computer correctly using the interface cable. (➞2-2)

● Is there sufficient charge left in the camera battery?
➞ Your computer does not supply power to the camera. Connect the DC Coupler Kit to the

camera or load a fully charged battery into the camera before connecting it to your
computer. (➞ “Inserting and Removing the Battery Pack” in the EOS D60 Instructions.)

● Do you have more than one interface cable connected?
If you connect more than one interface cable to the same computer, the Plug-In Module and
camera may not operate normally.
➞ Shut down the Plug-In Module and disconnect all the interface cables. Then reconnect

just the interface cable that connects the camera to your computer.

● Did you try to use the camera on a first-generation iMac without updating
your system software to Mac OS 8.6 or later?
Update the firmware using the iMac Firmware Update and then update the system software
to Mac OS 8.6 or Mac OS 9.
➞ You can download the iMac Firmware Update from Apple’s web site.
➞ Purchase Mac OS 8.6 or Mac OS 9 from your Apple retailer.
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Uninstallation Procedure
● Before beginning the software uninstallation, close any other software you are using and

disconnect the interface cable from your computer.
● When you have moved the software in the folders, control panels and extensions to be

deleted to the Trash, select [Empty Trash...] from the [Special] menu and empty the Trash.
You cannot reinstall the software until you have emptied the Trash.

● When you uninstall ImageBrowser, first use the procedure in [Uninstalling the Software] to
delete the [ImageBrowser] folder and then use the procedure in [Uninstalling USB Mounter]
to delete [Canon ImageBrowser Auto Launch] in the Control Panels.

Uninstalling the Software
This section uses the Plug-In Module as an example to illustrate how to uninstall the software.
The same procedure can be used to uninstall other software products, with the exception of
step 3. Step 3 is only required when you uninstall the Plug-In Module.

1 Display the folder containing the [Camera Plug-In] folder.
● Open the [Canon Utilities] folder.

2 Drag the [Camera Plug-In] folder to the Trash and empty the
Trash.

3 Drag the Plug-In Module you copied to the Trash and empty the
Trash.
● Drag [Canon Camera Plug-In 4] that you copied to the [Plug-Ins] folder for your

application program to the Trash and empty the Trash.
● If you use the Photoshop 5.0 LE application bundled, drag the [Canon Camera

Plug-In 4] file that was copied into the [Import/Export] folder inside the [Plug-Ins]
folder to the Trash and then empty the Trash.

● When you drag the folder to the Trash, take great care not to delete any important
images at the same time.

● When uninstallation ends, restart your computer.
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Uninstallation Procedure

Uninstalling USB Mounter
USB Mounter components are installed in the [Control Panels] and [Extensions] folders.
Consequently, its uninstallation procedure is different from that of the other programs.

1 Display the [System Folder].

2 Double-click the [System Folder] and then [Control Panels] to
open.

3 Drag the [Canon USB Camera Driver] file to the Trash and empty
the Trash.

4 Double-click the [System Folder] s [Extensions] to open.
● If there is no [Canon USB CameraMounter] file in the [Extensions] folder, open

[Extensions (Disabled)] in the [System Folder].

5 Drag the [Canon USB CameraMounter] file to the Trash and
empty the Trash.

Uninstalling Photoshop 5.0 LE

1 Display the folder containing the [Adobe Photoshop 5.0 LE]
folder.

2 Drag the [Adobe Photoshop 5.0 LE] folder to the Trash and empty
the Trash.

● When you drag the folder to the Trash, take great care not to delete any important
images at the same time.

● When uninstallation ends, restart your computer.



9-5

Tr
ou

bl
es

ho
ot

in
g 

an
d 

U
ni

ns
ta

lla
tio

n

Index
B
Browser window ....................................... 8-5

C
Camera Connection button .............. 3-4, 3-5

Camera Settings button ................... 3-3, 6-2

Camera Settings dialog box ..................... 6-3

Camera window ....................................... 8-6

CF Card Folder Structure and File
Names ...................................................... 2-4

Checkmark button .......................... 3-4, 3-14

Click white balance button ............. 3-4, 3-21

Click white balance checkbox ........ 3-4, 3-21

Click White Balance Function ................ 3-21

Color tone list box .......................... 3-3, 3-22

Comment input box ........................ 3-3, 3-16

Communication Setup button ........... 3-2, 3-3

Contrast list box ............................. 3-3, 3-22

D
Digital Exposure Compensation ............. 3-19

Digital Exposure Compensation button
....................................................... 3-4, 3-19

Disabling ImageBrowser Auto Start ......... 8-4

Display Mode list box ....................... 3-3, 3-9

Display Size list box ....................... 3-3, 3-11

E
Erase button ................................... 3-4, 3-17

Exit button .............................. 3-2, 3-4, 3-33

H
How to Disable the USB Mounter ............ 4-2

I
Image display format list box ........... 3-3, 3-8

Image Display Formats ............................ 3-7

Image information display area ...... 3-3, 3-16

Image recording formats and image
processing options ................................. 3-13

Image transfer mode list box .......... 3-3, 3-32

ImageBrowser ........................................... VII

Index Sheet Transfer Options dialog
box ......................................................... 3-32

J
JPEG Extract dialog box ........................ 3-28

JPEG Preview ........................................ 3-10

O
Open Folder button .......................... 3-4, 3-6

P
Photoshop 5.0 LE .................................... VIII

PhotoStitch ................................................ VII

Plug-In Module .......................................... VII

Plug-In Module main window ................... 3-3

Preferences button ......................... 3-3, 3-29

Preferences dialog box ............................ 7-5

Preferences dialog box

General Settings tab sheet ................. 3-29

RAW Image Processing Settings tab
sheet .................................................. 3-30

Preview .................................................. 3-10

Print window ........................................... 8-12

Protect button ................................. 3-4, 3-15

R
RAW Image Converter .............................. VII

RAW Image Converter main window ....... 5-2

RemoteCapture ......................................... VII

RemoteCapture

Save window ........................................ 7-3

Shooting window .................................. 7-3

Remove checkmark button ............ 3-4, 3-14

Remove protect button ................... 3-4, 3-15

Rotate left 90 degrees button ......... 3-3, 3-17

Rotate right 90 degrees button ...... 3-3, 3-17

S
Saturation list box .......................... 3-3, 3-22

Save File button ................... 3-4, 3-23, 3-27

Save File dialog box ............................... 3-25

Select button .................................. 3-4, 3-16



9-6

Index

Select image folder display area ....... 3-3, 3-5

Setting the Date and Time ....................... 6-4

Setting the Owner’s Name ....................... 6-4

Show Version button ................................ 3-4

T
Thumbnail display .................................... 3-9

Transfer Image button .................... 3-4, 3-32

U
USB Mounter ............................................ VII

W
White Balance ........................................ 3-20

White balance list box .................... 3-4, 3-20



9-7

Tr
ou

bl
es

ho
ot

in
g 

an
d 

U
ni

ns
ta

lla
tio

n

Adobe Systems Inc. technical support information is available in the PDF file format on the
supplied CD-ROM.

PDF File Location and Opening Instructions
Place the Adobe Photoshop LE CD-ROM in the drive. The window will open automatically and
show folders with language names. Double-click the appropriate language folder and the
[Support.pdf] file within it.

● To read PDF files, Adobe Acrobat Reader must already be installed on your computer. An
installer for this program is on the Adobe Photoshop LE CD-ROM within each language
folder in a folder labeled [Adobe Acrobat Reader].

Adobe Customer Support
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